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Chapterl. Overview
1.1. Specification

Flash

RAM

Data, Memory, Code
Retain area
Persistent area

File system

Memory

Processor
SD Card Slot

Ethernet

VO Port  com port

Local bus
CAN Bus
RTC
Input Power
Power Isolation
Power Dissipation
Current for Internal Bus
Current Consumption
Voltage Resistance
Isolation Resistance
Vibration Endurance
PCB Coating
Enclosure
Specification Dimensions WxHxD
Weight
Mount
Protection Structure
Storage Temperature
Operating Temperature
Relative Humidity
Certificate CE

Software

Power

Environment
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CODESYS PLC with lloT Gateway

Features

CODESYS PLC compliant with IEC61131-3
Fan-less Cooling System

Built- in 4GB Flash Memory and RTC

SD Card Slot Supports SD/SDHC Cards
Rich combination of iR Series Modules

Gateway

® COM2/COM3 RS-485 2W Supports MPI 187.5K
®  Supports OPC UA Server/Client and MQTT
®  Modbus TCP/IP Gateway

4GB
512 MB
3 MB
16 KB (every minute) (Kept after reboots)
16 KB (every minute) (Kept after downloads)
8MB
Dual-Core 32 bits RISC 1GHz
SD/SDHC
LAN 1: 10/100/1000 Base-T x 1
LAN 2: 10/100 Base-T x 1
COM1 RS-232 2W, COM2 RS-485 2W/4W,
COM3 RS-485 2W
iBus
N/A
Built-in
24+20%VDC
Built-in
Nominal 310mA@24VDC
Max 2A@5VDC
550mA@5VDC
500VAC (1 min.)
Exceed 50MQ @ 500VDC
10 to 25Hz (X, Y, Z direction 2G 30 minutes)
Yes
Plastic
50 x 109 x 81 mm
Approx. 0.24 kg
35 mm DIN rail mounting
IP20
-20° ~ 70°C (-4° ~ 158°F)
-10° ~ 50°C (14° ~122°F)
10% ~ 90% (non-condensing)
CE marked

EasyBuilder Pro V6.03.02 or later versions
CODESYS V3.5 SP10 Patch 3 or later
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1.2. Dimensions

Top View

50mm [1.97"] _81mm [3.19"]
s e e 2 e 5 i
BHS E £
3
@ ° 0 ‘_J'
Side View Front View Side View

Bottom View
a | RUN/STOP switch e | LAN1
b | Reset Button f | LAN 2

COM1: RS-232,
c | COM2: RS-485 2W/4W, g | SD Card Slot
COMS3: RS-485 2W

d | Power Connector h | Expansion Connector

V1.0.1
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1.3. Pin Assignment
COM1 [RS232], COM2 [RS-485 2W/4W], COM3 [RS-485 2W], 9 Pin, Male, D-sub

coMmL COMZ RS- 485] COM3
PIN# [RS-232] [RS-485] 2W

1 Data+
2 RxD

3 TxD

4 Data-
5 GND

6 Data+ Rx+

7 Data- RXx-

8 Tx+

9 Tx-

1.4. Restoring factory default
Press and hold on the Reset button on the unit for more than a certain period of time when the
RUN/Stop toggle switch (CODESYS switch) is in STOP state:

Period of time ERR LED Action

button is pressed

0~3 seconds No action.
3~10 seconds Blinking Reboot PLC and Gateway
Over 10 seconds Lights UP Reset to default. The projects stored in the unit will be cleared and LAN1,

LAN2 are reset to default.

Default settings of cMT-CTRLO1:

LAN 1: DHCP, CODESYS

LAN 2: DHCP, Gateway

Please note that the projects and data stored in the unit are all cleared after pressing the Default

button, please download the projects again.

1.5. LED indicator
LED indicators show the status of cMT-CTRLO1.

L.V LED

LV LED State
OFF 24V power normal

Blinking Detect 24V power

ON 24V power error

V1.0.1
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CPU LED

RUN

OFF OFF CODESYS STOP

ON OFF CODESYS RUN

Blinking OFF EBPro or CODESYS scans and the LED of the found unit
winks.

OFF ON CODESYS ERROR

Blinking Blinking BOOT

10 LED

RUN

OFF OFF Power off or no power

Blinking OFF 10 initiating

Blinking ON IO initiation error

ON OFF 10 working

ON Blinking IO module alarm

ON ON IO communication fault

Blinking Blinking Exceeds power limitation or too many modules
connected.

Ethernet

Orange LAN connection status
Green LAN communication status

1.6. Battery

cMT-CTRLO1 requires a CR1220 3V lithium battery to keep the RTC running.

Battery Specification: UL Certification Battery, Type CR1220, Rated 3V, Max. Abnormal Charging
Current 10mA, Working Temperature: max. 70°C

Battery replacement shall be performed by qualified personnel (Engineer) only and care must be
taken when handling lithium batteries. For more information on battery replacement and disposal

considerations, please refer to the following link:
http://www.weintek.com/download/MT8000/eng/FAQ/FAQ 103 Replace Battery en.pdf

1.7. Power connection

Power: The unit can be powered by DC power only, the voltage range is compatible with most
controller DC systems. The power conditioning circuitry inside the unit is accomplished by a
switching power supply. The peak starting current can be as high as 500mA.

cMT-CTRLO1 voltage range: 24+20% VDC

V1.0.1
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Power Connector Specifications:

Wire AWG: 24~12

Wiring Conductor Minimum Temperature: 75°C
Screw Torque: 4.5 Ibf-in (max.)

Copper conduct only

N
24VDC FG

Note: Connect positive DC line to the '+' terminal and the DC ground to the '-' terminal.

1.8. Power Consumption

Type Device Consumption(5V) Power Supply(5V)

CPU iR-CTRLO1 550mA/2.75w 2A/10w
iR-DM16-P | 130mA/0.65 W -
iR-DM16-N | 130mA/0.65 W -

Digital 1/O iR-DQOS-R 220mA/1.1 W -
iR-DQ16-N 205mA/1.02 W -
iR-DQ16-P 196mA/0.984 W -
iR-DI16-K 83mA/0.418 W -
iR-AQ04-VI | 65mA/0.325 W -
iR-Al04-VI 70mA/0.35 W -

Analog 1/0 -
iR-AM06-VI | 70mA/0.35 W -
iR-Al04-TR 65mA/0.325 W -

Motion iR-PUO1-P 108mA/0.54 W -

Note:

The coupler is the only power supply for the modules in this system. Please consider power requirements when connecting
multiple modules. The following is an example.

Device Name Consumption Power Supply
CPU iR-CTRLO1 550mA/2.75w 2A/10w
Module iR-DM16-P *11 130mA*11=1.43A X
System Power consumption : 550mA + 1.43A =198 A

Power supply: 2A > 1.98A

V1.0.1
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Chapter2. cMT-CTRLO1 System Setting
Connect cMT-CTRLO1 via Ethernet cable, and then configure system settings by the following ways.

2.1. Search for cMT-CTRLO1’s IP address

Launch UtilityManagerEX. On the top-left menu select cMT Series, and then select a function from
Reboot, Download, or Upload. cMT-CTRLO1 can be found in the IP/HMI Name group box by using
the model’s IP address, even if the PC or laptop is not on the same network. UtilityManagerEX can
find and change cMT-CTRLO1’s IP address. The following settings can be carried out after obtaining
the IP address.

4| 1P HMIName b
HMI: [cMT-5308 ~||192.168.2.14 (cMT-AS7C) ‘

192.168.2.148 (cMT-F5E2)
Search 192.168.3.177 (cMT-OPCUA-RRRR

2. z
Search Al 192.168.3.20 (cMT-5309]

[ seachand Change P}
Password : [Ferr | EAmask
Port No. Setting...
Reboot
Search and Change IP X
HMI Hame | IP HMIModel | Ma bHCP : @0On Ooff
eI - T-CTELOL m
cMT-407C 192168214 cMT-CTRLOL 004 [12 . 18 . 5 . = ]
chT-FSE2 192.168.2.148 cMT-G01 Ga... 00
cMT-OPCUA.. 192.168.3177 cMT-GOL Ga.. 00 [255 . 255 . 252 . 0 |
Password : |..oooo |
Blink LED Apply
£ >
Refresh Exit

2.2. Set in internet browser
Open internet browser (IE, Chrome, Firefox, Safari), and enter cMT-CTRLO1’s IP address (e.g.
192.168.100.1) to configure cMT-CTRLO1.

V1.0.1



cMT-CTRLO1 User Manual

[all=]E] %=
[ Welcome to cMT serie X\D
& (&) i @® 192.168.100.1/web_ihmi/index.php QW ‘ :

Please Login!

S
setting

’S\v'stem setting password x‘

s LOGIN &

INFORMATION

) Bie/12001
@ ](-)m2'é:15:03 pm

cMT-CTRLO1 system information is shown in the Login page, and the language used can be changed

in this page.

Description

Displays HMI name.

Date
!) 2016/1 2/01 Displays system date.

Time
@ 02:15:17 pm Displays system time.

Please note that by default, LAN 2 is assigned for Gateway (DHCP).

2.3. System Setting
The following part introduces cMT-CTRLO1 system settings.

V1.0.1
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Please Login!

System .
Update History
setting

System setting password

Three levels of privileges can be found:

[System Setting]: Controls all the settings

[Update]: Controls limited items.

[History]: Downloads history data (Recipes and Event Logs).

2.3.1. Network
Configure Ethernet ports: IP, Mask, Gateway, and DNS.

cMT-CTRLO1 is equipped with dual Ethernet ports that can be freely assigned as one of the

following:
1. One Ethernet port for CODESYS (LAN1, DHCP) and the other one for lloT Gateway (LAN2
DHCP).

2. Both Ethernet ports for lloT Gateway
Select [Enable CODESYS login] to log in using LAN2’s IP address in CODESYS.

® .

identity:
Syster%ySetting

(@ Network Network
Date/Time
HMI Name Ethernet
@ WANI(LAN2)
Hismry MAC address : 00:0c:26:18:a9:82

Email

Project Management IP Address Ethernet

@ Obtain IP address automatically Use static IP address below
System Password
Enhanced Security
IP: 192 . 168 - 2 . 38
EasyAccess 2.0 Mask: 255 . 255 . 252 . O
Gateway: 192 . 168 . 1 - 254
OPCUA DNS: 168 - 95 - 1 - 1

Communication
Enable CODESYS login

Save

CODESYS

2.3.2. Date/Time
Set RTC date and time. Select [Sync. with host] and then click [Save] to synchronize cMT-CTRLO1

time with the computer time.

V1.0.1
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. identity:
l System Setting
Network Date/Time
(® Date/Time
HMI Name Current date/ time 2019/08/15 06:25:05 pm
History
New date/ time:
Email “« <+ August2018 >
- Su Mo Tu We Th Fr Sa
Project Management
12 3
System Password el sl6l 718l 9]0

Enhanced Security

EasyAccess 2.0 % 26 27 28 20 20 3
OPC UA

Communication Hrs  Min  Sec
CODESYS i R :

Sync with host.

2.3.3. HMI Name
Enter a name to identify the unit.

[Identification light]: The LED indicator of the unit will flash three times when this button is clicked,

helping user to find the unit.

identity: | Logout TR NCEE
Sysler}\ySetting

AA =

vl a -
N HMI Name

Date/Time

Current HMI name: cMT-8E9C Identification light
& HMI Name

History New HMIName: | New HMI Name

Emiail

2.3.4. History
This tab offers settings related to historical data.

[Clear]: Clears history data.
[Backup]: Downloads history data in the unit to this computer.

V1.0.1
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. x identity;

System Setti ng

Network H|Sfory

Date/Time
Clear  Backup
HMI Name

. Clear Recipe (recipe.rcp, recipe_a.rcp)
History

Email Clear Event Log

Project Management Clear Data Log

System Password

Enhanced Security
EasyAccess 2.0
OPC UA

Communication

2.3.5. Email
This tab offers settings related to email.

[SMTP]: Configure email server and relevant settings.
[Contacts]: Set email contacts in this tab.
[Update Email Contacts]: Import the email contacts built using Administrator Tools.

. identity: |
L Systertny Setting Logo!

Network Email

Date/Time

SMTP  Contacts  Update Email Contacts
HMI Name

) Mail feature is not enabled.
History

A Email

Project Management

Server: SMTP server Port:

SMTP server requires authentication

System Password

w Use the following type of encrypted connection

Enhanced Security O ms ssk
EasyAccess 2.0 User name: User name
OPC UA
Password: Password Confirm password: Confirm passv
Communication
CODESYS Sender information
Name: Sender name Use HMI name
Mail address: Sender mail

Save

2.3.6. Project Management
This tab offers settings related to project management.

[Restart Project]: Restart cMT-CTRLO1 project.

V1.0.1
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[Update Project]: Upload the project’s *.cxob file to cMT-CTRLO1.

[Backup Project]: Backup the project file to this computer.

[USB/SD Update]: Use the project file stored in the external device to update the project file on
cMT-CTRLO1.

® .

Network Project Management

Date/Time

identity:
Syster*lyS etting

Restart Project  Update Project  Backup Project  USB/SD Update
HMI Name

Please click following button to restart Project.

History

Email Restart EB Project

B Project Management
System Password
Enhanced Security
EasyAccess 2.0
OPC UA
Communication

CODESYS

2.3.7. System Password
Set login password and the password for transferring project file.

® .

identity:
Systent1y5etti ng

Network System Password
Date/Time
HMI Name Please select identity to edit password.
History System Setting ~
Email

Current password: Current password
Project Management

New password: New password

ﬂ System Password

Enhanced Security Confirm new password: Confirm new password
EasyAccess 2.0
OPCUA

Communication

CODESYS

2.3.8. Enhanced Security
The account settings in this tab determine the accounts that can log in OPC UA.

[Accounts]: Add user or change user password and operable classes.

[Import User Account]: Import the user accounts built in Administrator Tools.

V1.0.1
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identity:
x Systergly Setting

Network Enhanced Security

Date/Time
Accounts

Import User Accounts

Add account

HMI Name
History

Email Please click [Save] button after editing data.

Project Management

1 admin 111111 v

System Password

&% Enhanced Security

2 userl 1 v
EasyAccess 2.0 “ K
OPCUA

3 user2 2 v o
Communication K 4
CODESYS

4 user3 3 ‘, o

/, 4

2.3.9. EasyAccess 2.0 (Optional)

BE =T == [e]E]E]
v v

cMT-CTRLO1 User Manual

¥ cMT-A982 06:31:14 pm 2019/08/15

Save

v v v v v v v v v

Edit

Delete

Edit

Delete

Edit

Delete

This tab shows Hardware Key, EasyAccess 2.0 activate status, and proxy settings.

For more information on EasyAccess 2.0, please see EasyAccess 2.0 User Manual.

identity:
Syster;ySEtting

® .

Network EasyAccess 2.0
Date/Time

EasyAccess 2.0 Proxy
HMI Name

History

Account: Account

Email
Password: Password

Project Management

System Password

Hardware key E7IHI73X-4VBI-ZN2I-HKFT-QI2E-YX6FYTU2

Detect activation status

Enhanced Security

"3 EasyAccess 2.0

OPCUA
Communication

CODESYS

2.3.10. OPA UA

Configure OPC UA settings. Please see “Chapter 6 OPC UA Web Management Interface” in this

manual for details.

2.3.11. Communication

This tab displays the communication parameters of the device connected to cMT-CTRLO1, and the

parameters can be changed in this tab.

V1.0.1
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iden
Systenrwy etting

Network

Date/Time

HMI Name

History

Email

Project Management
System Password
Enhanced Security
EasyAccess 2.0

OPCUA

i Communication

CODESYS

Communication

Device Type

® MODBUSRTU MODBUS RTU, RTU over TCP

Mitsubishi FX3U/FX3G  Mitsubishi FX3U/FX3G

Rockwell DF1 Rockwell DF1

COM Port Settings ( PLC #3)

Interface :

Baud Rate :

Data Bits :

Parity :

Stop Bits

Timeout (100ms) :
Turnaround Delay (ms)
Parameter 11

Parameter 2 :

Send ACK Delay @

RS485 2W

Even

1bit

L

COM 3 (9600E8,1)
COM 2 (38400E7,1)

COM 1 (9600,N,8,1)

Protocol Default Station No

RS485 2W

RS485 4W

RS232

1

N/A

1

13
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Parameters that can be viewed and modified for a device connected via COM port.

Interface
Baud rate
Data Bits
Parity
Stop Bits
Timeout
Parameter 1
Parameter 2
Send ACK Delay
Parameters that can be viewed and modified for a device connected via Ethernet.
IP Address
Port
Timeout

Turnaround Delay
Parameter 1
Parameter 2

Send ACK Delay

14
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Chapter3. Updating Web Package and OS
cMT-CTRLO1 Web Package and OS can be updated through Ethernet. Launch Utility ManagerEX,
select [Gateway Series] » [Maintenance] » [cMT-Gateway OS Update].

Administrator Tools @ ]

. Build user account and mail setting files in a
Design e | USB drive/SD card without modifying project
file, and then transfer them to HMI by USB/SD.

Analysis &
Testing

cMT-Gateway OS Update @
Update OS on cMT-Gateway
Publish

CODESYS Firmware
Upgrade
Upgage CODESYS firmware on HMI @

Maintenance

BEIE]
Conversion

Run ® Edit®

3.1 Updating Web Package

1. Select an HMI to update OS.

2. Select [Web package] and browse for the source file.
3. Click [Update].

cMT-Gateway OS5 Update *

Z

1
I
4 P HMI Name b
HMI: |cMT—5309 v | 192.168.2.148 (cMT-F5E2) ~

192.168.2.174 (cMT-MikeGO2dev)

192.168.3.14 (cMT-A377)
Semcn Al || {288 3TB 5315

| SearchandChangelP || 192168.326 cMT-4738) v |
1
|
(®) Web package | C:\web_ihmi.bin| |
Dos
(DR firmware

3.2 Updating OS
1. Select an HMI to update OS.

V1.0.1
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2. Select [0S], a Warning message shows, please read this message carefully before you click [OK].

Warning @

QS Firmware upgrade is a critical operation, Please make sure power stays on
and do neot disconnect before the update is completed. Contact your service
provider if you are not sure of this operation. After update is completed, the

system will automatically reboot .

Begin firmware update procedure

| oK | ’ Cancel ]

3. If you click [OK], the cMT-Gateway OS Update window opens again, browse for the source file,

and then click [Update].

cMT-Gateway 05 Update

4 1P HMI Name

HMI: | eMT-5309 v| 192.168.2.148 (cMT-F5E2) ~

Sgarch Al 192.168.3.18 (cMT-5315) —
Search and Change IP c- -

192 1682174 (cMT-MikeG02dev)
Search 192.168.3.128 (cMT-8ED3)
192.168.3.14 (cMT-AS77)

(Z) web package
®os [ £+\Users\ab0s3\Downloads \O5_cMT-CTRL_20 190731\WTFirmware_CTRL bin =]
(iR firmware

Password ; | =seses | EAmask Update

4. The message window below opens, please do not turn off the power while upgrading.

UtilityManager

Do you want to start the upgrade?

! (Your device will be upgraded after clicking Yes. Mote this operation
may take a few minutes.
Again, please do not turn off the power while upgrading.)

o

5. When finished, cMT-Gateway OS Update window shows “finished”.

V1.0.1
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cMT-Gateway OS Update

4| 1P HMI Name

Search
Search All
Search and Change IP

HMI: |cMT-5309 ~ [ [192.168.2.148 (cMT-F5E2)

192168 2174 (cMT-MikeG0D2dev)
192.168.3.128 (cMT-2ED3)
192.168.3.14 (cMT-A977)

(O web package

®@os [cr\Users\aboa3\Downloads\OS _cMT-CTRL_20190731\TFirmware_CTRL.bin |

OR frmware

connecting HMI and checking password
downloading OS...

Updating OS...

finished

Password ; | ======
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Chapter4. How to create

This chapter explains how to create a project when cMT-CTRLO1 is used as an OPC UA Server. The

basic steps are:

1. Add a driver into Device List

a cMT-CTRLO1 project

in EasyBuilder Pro.

2. Enable OPC UA Server and designate communication address.

3. Download the project to HMI.

Add drivers Services

Add drivers for connected
controllers/PLC/inverters/..

4.1. Create a new project

Add services for SCADA/office/
external system 1o access.

Corcur J v

Step 1. Launch EasyBuilder Pro and select a cMT-CTRLO1.

cMT-CTRLO1 User Manual

Download

Final step.
Transfer this configuration to
the device.

The following explains how to set up OPC UA Server in the project.

CON New Project

Open  Model: [V @

v e

|

cMT Series A
cMT3071 (800 x 480)
cMT3072 (1024 x 600)
cMT3090 (1024 x 768)
cMT3090X (1024 x 768)
cMT3103 (1024 x 600)
cMT3151 (1024 x 768)
cMT3151X (1024 x 768)
cMT-5VR (1024 x 748)
cMT-SVR-200 (1024 x 748)
cMT-HDM (1320 x 1080)
cMT-FHD (1920 x 1080)
cMT Series - Gateway
cMT-GO1 Gateway
cMT-G02 Gateway (Built-in Wifi)
cMT-GO3 Gateway (Serial Bridge)
cMT-G04 Gateway (Ethernet Bridge)
<MT-CTRLO1
mTV Series

T\L100 (1280 . 72m

Use template (template_CTRLO1.crtp)

CMT-CTRLOT

COM1:R5-232

COM 2 : RS-485 2W/4wW
COM 3 : R5-485 2W
Ethernet: LAN 2, LAN 1
WIFT: NA

CAN Bus: NA

SD Card Slot : Yes

USE Host: NA

‘Uncompress Project‘ ‘.L Demo Projectl

Step 2. Add a device into the list and configure communication parameters.

System Parameter Settings

Device Model General System Remote Security Time Sync/DST  e-Mail

Device list: What's my IP?
MName Location Device Type Interface |/F Protocol Station Mo.

v Local HMI Lacal cMT-CTRLO1 - - ]
MODBU... Local MODBUS ... Etherne.. TCP/IP 1

V1.0.1
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Click [IloT/Energy] » [OPC UA Server], and select [Enable] check box to enable OPC UA

Step 3.
Server.
QPC UA Server
] Enable
Server
Settings...
Tag
@ Local HMI ST T
| MODEUS TCP/IP
MNew Tag...
Step 4. Click [Tags] of the device and then click [New Tag] to add tags monitored using OPC UA.
When finished, click [OK] to leave.
Mew Tag x
|
Name : |Monihnr Ax-1
Type
OBt @ Word
Address
Device :  MODBUS TCR/IP Sattings...
Address @ | 4x ~ 16-bit Unsigned
*You can scale/convert data with conversion tag in Tag Library.
Type
[ Readable
conce
Step 5. Find the created tags in OPC UA Server window. When a large number of tags are used,

the tags can be exported as a csv/excel file to be edited and then imported again.

OPC UA Server

Server
Settings...
Tag
BF :Local HML New group...
B T Tags
—— Mew Tag...
B Monitor LW-0 Delete
MODBUS TCP/IP
[ ::Tags Settings...
[l Monitor 4x-1
Import...
Export..
Exit

4.2. Download project to cMT-CTRLO1
The format of the project file run on cMT-CTRLO1 is *.cxob. In EasyBuilder Pro, click [Project] »

V1.0.1
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[Compile] to compile the project into *.cxob format. When finish compiling, you can download the

project to cMT-CTRLO1 by two ways.
Way 1: Download using EasyBuilder Pro. Click [Project] » [Download(PC->HMI)], and set HMI IP

address. The project can be downloaded via Ethernet.

Download (PC-=HMI) b4
(®) Ethernet Password/Port na. of downloadfupload : | Settings...
q IP HII MName I
HMI - |cMT—53DQ w | [182.168.2.14 (cMT-AS7C
192.168.3.20
Search
Search All
Search and Change IP
¥hat's mey [P?
Runtime *Mecessary if update runtime or execute download first time.
Reset event log Reset data sampling
[ automatically using current settings to download after compiling
| Download | Stop Exit

Way 2: Download using website. Open internet browser (IE, Chrome, Firefox), enter cMT-CTRLO1’s
IP address (e.g. 192.168.100.1), click System Setting, enter password, and then configure
cMT-CTRLO1 settings. Go to [Project Management] page and open [Upload Project] tab to
download the project file from the computer to cMT-CTRLO1.

V1.0.1
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identity:
i 3 Systemi Setting

e Project Management
Date/Time
Restart Project  Update Project ~ Backup Project  USB/SD Update
HMI Name
History Please select item(s) to update
" Project EEEE | EEProjectl.cxob
Email W
BY Project Management [0 rwa

System Password

Enhanced Security

EasyAccess 2.0

OPCUA
Communication

CODESYS

Upload

4.3. Monitoring OPC UA Client
After downloading the project file, use OPC UA Client software to connect with cMT-CTRLO1 to

monitor PLC data.

[ Unified Automation UaExpert - The OPC Unified Architecture Client - MewProject* == ==

Eile View Server Document Settings Help

(PPBO =0 XYWl B <

Pmoject & X | Datohecess Tiew [x]
4 [ Project # Server NodeId Display Name Value Datatype ource Timestam)| erver Timestam;  Statuscode
L D Servers 1 UaServer@cMT.. NS2|String|MO.. Monitor 4x-1 o Ulntl6 P 01:45:41.139 PM 01:46:55.565 Good
12 UaServer@cMT-4B36 - None - Nong 2 UaServer@cMT.. NS2|StringlLoc... Monitor LW-0 0 Ulnt16 P 01:4%:48.701 PM 01:49:48.701 Good

23 UaServer@cMT-BEIC - None - Nong
4 [1 Documents
[J Data Access View

4 mn

ALddvess Space =
5 [Wo Bighlight
) Root
4 [ Objects
4 (3 Local HMI
> [ HMIInfo
a ) Tags
> @@ Monitor LW-0 r
4 |3 MODBUS TCR/IP
a ) Tags
> @@ Monitor4x-1
> g Server N
> D Types <[ r" ] »

s |« x =

Note: The above is a screenshot of UaExpert. For more information on OPC UA Client software

settings, please see OPC UA server manual.

4.4. On-line/Off-line Simulation

Running On-line or Off-line simulation in EasyBuilder Pro helps you examine OPC UA Tag settings. In

On-line simulation, cMT Gateway Viewer can read from / write to PLC. Please note that On-line

simulation is limited to 10 minutes.

Step 1. In EasyBuilder Pro click [Project] » [On-line Simulation] / [Off-line Simulation] to open
cMT Gateway Viewer window.

Step 2. Add the tags to be previewed into the Monitor list on the right side.
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Step 3. In On-line Simulation, data in PLC tags will also change.

7] cMT Gateway Viewer (Simulation)

e Server Status

Connected

[E=3 EoR )

Browser Check nodes status Monitor [Remove unavailable nodes| Remave all nodes

MName Status MName d DataType Value
‘;ﬁEHMI Monitor LW-0  N$2|String|Z=# HMLTags.Manitor LW-0  Ulnt1é ]
4 Tags Monitor 4x-1  NS2|String|MODBUS RTU Tags Monito. Ulntls 0
Manitor LW-0 Readable
4 MODBUS RTU
4 Tags
Manitor 4x-1 Readable

V1.0.1
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Chapter5. Functions supported by cMT-CTRLO1

OPC UA Server
http://www.weintek.com/download/EBPro/Document/UMO016009E OPC UA UserManual en.pdf
EasyAccess 2.0 (Optional)

http://www.weintek.com/download/EasyAccess20/Manual/eng/EasyAccess2 UserManual en.pdf
Modbus TCP/IP Gateway

OPC UA Client

MQTT Server / MQTT Subscriber / MQTT Publisher

Administrator Tools

Time synchronization (NTP)

Macro

Project protection

iE/XE/eMT/mTV communication protocol
Pass-through

Data Transfer (Global) object

Off-line / On-line Simulation

Recipes (RW, RW_A)

Event Log (please note that cMT-CTRLO1 cannot read history data saved in an external device)
E-Mail

Scheduler

Web interface for managing OPC UA and communication parameters

V1.0.1
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Chapter6. OPC UA Web Management Interface

6.1. Introduction

cMT-CTRLO1 provides a web-based tool for convenient access to OPC UA configurations.

€ D& 192168222 hmi/index.php wx e Q&g *8 O ¢ A O =

© EXTE

Please Login!

System 4
Update | History
sefting

GIN &

| INFORMATION

!) 2017/07/19
g 11:41:00 am

Open cMT-CTRLO1’s webpage by entering its IP address into the address bar of a web browser. At

the entry page, log in with System setting’s password. Factory default of the password is 111111.
(Suggested resolution: 1024x768 or higher)

tting
Network OPC UA
Date/Time @ ' OPCUAServer © Status:Running
HMI Name Qopciop://192.168.3.20:4840/cMT-CTRL
History ServerSemings  Editnode  Certificates  Discovery  Advanced
Email
mat General
Project Management

Port: 4840

System Password
Servername:  cMT-CTRL

Enhanced Security

Security
EasyAccess 2.0 policy:  None
@ OPCUA « Basic128Rsals Sign;Sign & Encrypt
@O + Basic2s6 Sign;Sign & Encrypt
CODESYS + Basic256sha256 Sign;Sign & Encrypt
Option: " Automatically Trust All Client Certificates

User Authentication

4 " User name & password + Certificate
Anonymous
Browse dlass: Class:A
' Browse Read class: Class:A
o Read Wiite class Class:A
Write

*Edit users setting in [Enhanced Security] and use corresponding permission classes (browse/read/write).
*If setting changes are made while OPC UA server is running, the server will restart momentarily for the changes to take effect.

Navigate to the OPC UA configuration page from the context menu on the left.
The OPC UA configuration page consists of a Startup/Shutdown control with status bar and tabbed
windows including: Server settings, Edit node, Certificates, Discovery, and Advanced.

V1.0.1
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Usage of each window tab:

LEL Description

. Configure server settings such as port, name, security, user
Server settings o
authentication......etc.

Edit node Manage tags used by OPC UA server.

Certificates Manage certificates used by OPC UA server.

Discovery Manage list of discovery server.

Advanced Advanced options and features.

6.2. Startup / Shut Down
OPC UA

I OPCUA Server © Status: Stopped
°opc.tcp://l 92.168.2.222:48011/G01

OPC UA

@ ' OPCUAServer @ Status:Running e
©Qopc.tcp://192.168.2.222:48011/G01

Use the toggle button to start up or shut down the OPC UA server. If there is active client
connection, when shutting down, the server will wait for a few seconds before closing off
completely.

In addition, both the toggle button and a line of text also indicate the status of the server. The status
is refreshed approximately every 10 seconds. An icon on the right ©* indicates that the status is
being refreshed.

Endpoint URL is also displayed for user’s reference.

*Whenever a page refresh is desired, use the menu on the left. Avoid using the browser’s refresh

button to reload a tab as you may be asked to enter the password to log in again.

6.3. Server Settings
The Server settings page shows general configurations of the OPC UA server.
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etting

Network OPC UA

Date/Time @ OPCUAServer @ Status:Running
HMI Name ©opcicp://192.168.3.20:4840/cMT-CTRL

History ServerSettings  Editnode  Certificates  Discovery  Advanced

Email
General

Project Management
Port: 4840

System Password

Servername:  cMT-CTRL

Enhanced Security
Security
EasyAccess 2.0 policy: + None
& OPCUA + Basic128Rsal5 Sign;Sign & Encrypt
Communication " Basic256 Sign;5ign & Encrypt
CODESYS +* Basic256sha256 Sign;Sign & Encrypt
Option, + Automatically Trust All Client Certificates
User Authentication
Cd «# User name & password  Certificate
Anonymous
Browse class: Class:A
o Browse Read class: Class:A
+ Read Wirite class: Class:A

Write

*Edit users setting in [Enhanced Security] and use corresponding permission classes (browse/read/write).
*If setting changes are made while OPC UA server is running, the server will restart momentarily for the changes to take effect.

Save

General Function

Port Access port of the OPC UA server

Server name Server name of the OPC UA server

Supported security policies. At least one must be selected.
Security policy  Supported Policy: None, Basic128Rsal5, Basic256, Basic256sha256
Mode: Sign, Sign & Encrypt

Opti Automatically Trust all client certificates: by enabling this option, the
ption

OPC UA server will trust the certificate from any client connection.

OPC UA server must be configured with at least one user authentication mode as listed in the
following table.

Authentication Descriptions

Allow anonymous client connection. At least one of Browse, Read, or

Anonymous )
Write modes must be selected.

Allow user authentication with username and password. Each access

User name & mode, browse, read, and write can be assigned to a user class. User

Password classes are configured in the Enhanced Security mode on the web
interface or in EasyBuilder Pro.

Certificate User authentication with X.509 certificate
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After completing settings, click the Save button to save the changes. OPC UA server will shut down

momentarily and then restart for the changes to take effect.

6.4. Edit Node

Network
Date/Time
HMI Name
History

Email

Project Management

System Password
Enhanced Security
EasyAccess 2.0

T OPCUA

Communication

CODESYS

identity:

ISyes:lelrswySetling

OPC UA
@ ' OPCUAServer @ Status: Running
Qopctcp://192.168.3.20:4840/cMT-CTRL

Server Settings  Editnode  Certificates  Discovery

Tags

v Lecal HMI
w Tags
B Sys_Tags
CODESYS
Comm Error Codes
Comm Parameter Settings
‘Comm 5tatus and Control COM
‘Comm Status and Control Ethernet

EasyAccess 2.0

v v v v v v

HMI Operation
i 8 LB-11959 : LED indicator control
B LW-10884 (16 words) : HMI name

H LW-11159 (16bit) : memory loading

momentarily for the changes to take effect.

Save

Advanced

[ Add Group

B+ Add Tag.

Expand all /

% cMT-5309 B 05:54:17 pm 2019/09/]

2] m Information
Collapse all Tag Name: LB-11959 : LED indicator
= control
Type: Bit
PIC: Local HMI
Address: LB 11959
Index register:  N/A
Date type: BOOL
Length: 1
Access: Read | Write
2]

o

*After editing the tags, use the Save button below to apply the changes to the OPC UA serverlf OPC UA server is running, the server will restart

In this page, the user can view and manage the tags currently available in the OPC UA server. New

nodes and groups can be added, while existing nodes and groups can be edited or deleted. For ease

of navigation, detail information of the currently selected node/group is displayed on the right.

After completing settings, it is necessary to click the Save button to save the changes. OPC UA

server will shut down momentarily and then restart for the changes to take effect. Changes will be

lost if one exits this page without saving.

V1.0.1
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TagMName:  LB-11959: LED indicator contro|

Type: @ Bit Word

PLC: Local HMI

Address: LB - 11959
Format: DDODD [range : 0 ~ 12799]
Index register:

Length:

Access: o Readable " Writable

Note that all modifications can only be made for existing drivers. It is not possible to change or add
other drivers that are not already available. It is also not possible to edit the nodes used by tag
PLCs*.

*Tag PLCs are characterized by their use of name tags as device memory address as opposed to
using device name with indices. Examples of tag PLCs include: BACnet, Rockwell Free Tag Names,
Siemens $7-1200/1500 Symbolic Addressing,...etc.

6.5. Certificates
In this page, the user can manage certificates and revocation lists of the OPC UA server. Use the

dropdown menu to access each page.

If “Automatically Trust All Client Certificates” (in the Server settings tab ) option is not enabled, OPC
UA server will reject all client connections and place their certificates in the untrusted list. User may

manually “trust” them in this page. Use the reload button & to repopulate the list of certificates if
necessary.

Similarly, currently trusted certificates can be manually rejected on the same page.
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Network

Date/Time

HMI Name

History

Email

Project Management
System Password

Enhanced Security

EasyAccess 2.0

™ OPCUA
‘Communication

CODESYS

cMT-CTRLO1 User Manual

identity: | Logout % cMTI-5309 B 05:56:55 pm 2019/09/23
byster%ySenlng

OPC UA
@ ' OPCUAServer O Status: Running
©opc.tcp://192.168.3.20:4840/cMT-CTRL

Server Settings  Editnode  Certificates  Discovery  Advanced

[ Own -lo
Name Velidfrom Validto  Organizaion  OrganizationUnit URI
UaServer@cMT-5309 2019/08/28 203%/08/23 Organization Unit umn:cMT-5309-Weintek:-UaServer, DNS:cMT-5309
Certificate: | BEFMER | FBHFIE TR | Remove Certificate
Private Key: | SEIFAERE | BT TR

Page Description

Trusted Clients

Lists of trusted/rejected client certificates on the server.

Supported operation: Trust/Reject, Remove, Import, Export.

Trusted Users

Lists of trusted/rejected user certificates on the server. Supported
operation: Trust/Reject, Remove, Import, Export.

Own

Server’s own certificate.

Supported operation: Update, Remove.

When updating own certificate, matching certificate and Private Key
must be uploaded together; otherwise, update will fail.

A self-signed, 20-year validity certificate will be generated
automatically if own certificate is absent when server starts up.

Trusted Client

Issuers

List of trusted client issuer certificates.
Supported operation: Import, Remove, Export.

Trusted User
Issues

List of trusted client issuer certificates.

Supported operation: Import, Remove, Export.

Certificate

Revocation List

Certificate revocation lists for client, user, client issuer, and user issuer.

Supported operation: Import, Remove, Export

6.6. Discovery

OPC UA server can register itself with Local Discovery Servers. In this page, the user can maintain

the list of discovery servers that OPC UA server will register with during startup. Should the

discovery server be unavailable during server shutdown, the shutdown process will be slightly

delayed.
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identity: |
1 Syste H?Setl'lng

Network OPC UA

Date/Time @ ' OPCUAServer @ Status: Running

HMI Name Qopc.tcp://192.168.3.20:4840/cMT-CTRL

History Server Settings  Editnode  Certificates  Discovery  Advanced

Email
Server URL Comment

Project Management
opc.tcp://192.168.1.81:4840/

System Password

Enhanced Security

EasyAccess 2.0

. OPCUA
Communication

CODESYS

Add |

cMT-CTRLO1 User Manual

% MT-5309 B 01:16:18 pm

*Server shutdown may be slightly delayed if the registered discovery server is unavailable at that time.
*|f setting changes are made while OPC UA server is running, the server will restart momentarily for the changes to take effect.

After completing settings, click the Save button to save the changes. OPC UA server will shut down

momentarily and then restart for the changes to take effect.

6.7. Advanced

Additional settings can be configured in the Advanced tab. The user can set the trace logging level

and specific startup behavior of the OPC UA server. Furthermore, the trace log can be downloaded.

Network OPC UA

Date/Time @ ' OPCUAServer @ Status:Running

HMI Name Qopc.tep://192.168.3.20:4840/cMT-CTRL

History Server Settings  Edit node  Certificates  Discovery — Advanced

Email . . .
AMllow server to start with an expired certificate

Project Management
Trace Log: MNone @ FError Debug Al

System Password

Enhanced Security
EasyAccess 2.0

@ OPCUA
Communication

CODESYS

% MI-5309 ® 01:17:01 pm

After completing settings, click the Save button to save the changes. OPC UA server will shut down

momentarily and then restart for the changes to take effect.

V1.0.1

30



cMT-CTRLO1 User Manual

Chapter7. Installing Weintek Built-in CODESYS
Installing Weintek Built-in CODESYS allows users to easily create a cMT+CODESYS project in
CODESYS software. Please find the Package file we prepared and follow these steps for quick
installation.

1.  First, get a copy of CODESYS Package file.

gt

weintek_2018012

4.package
2. Onyour PC, right-click the mouse button and select [Open with CODESYS Package
Manager].
Open with CODESYS Package Manager
Open with...
Share with 3

Restore previous versions
Send to 2

Cut
Copy

Create shertcut
Delete

Rename

Properties

3. Select Complete Setup or Typical Setup (you may select any of these setup types since the
components used by Weintek Built-in CODESYS exist in both types.)

fJ Installation - Choose Setup Type @
Weintek Built-in CODESYS [2018.1.24]
Please selectthe typeof setup youwould liketo perform. EI

@ Complete setup

All package components will be installed.

) Typical setup
The most commonly used package components will be installed.

Cancel Next =

4. Click [Next] when seeing the following message.
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& Installation - Setup Completed IEI
Weintek Built-in CODESYS [2018.1.24] a
WEINTEX

The package has been successfully installed. Click Finish to exit the wizard or Mext to see
the summary.

[ Next> | [ Finish |

The installed component will be shown in the installation summary.

& Installation - Summary IEI
Weintek Built-in CODESYS [2018.1.24]
Installation summary m

Summary:

= Device description (1)

Component/DeviceDescription/Weintek-Cortex-embedded.devdesc.xml: Iter

4 m 2

cMT-CTRLO1 User Manual
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Chapters.

8.1. Connecting Through Network
Connect cMT-CTRLO1’s LAN 1 port with a router or PC.

Open internet browser (IE, Chrome, Firefox, Safari), enter cMT-CTRLO1’s IP address (e.g.
192.168.100.1), and then configure cMT-CTRLO1 settings.

Open CODESYS page to see the IP address. By default DHCP is used for cMT-CTRLO1

1.
2.

CODESYS IP.

Network

Date/Time

HMI Name

History

Email

Project Management
System Password

Enhanced Security

EasyAccess 2.0

OPCUA
Communication

li CODESYS

8.2. Creating CODESYS Project
Launch CODESYS V3.5 and click [File] » [New Project], and then select [Standard project].

Enter the project name in Name filed, browse for the location, and then click [OK] to

1.

V1.0.1

Connecting cMT-CTRLO1 CODESYS

identity:
‘_'\yslerhy Setting

CODESYS
Status

Project update

Activation Status: Activated

Start

CODESYS status:
Application status:
Login status:
Ethemet{LAN1}):
IP address
Subnet mask
Gateway

CODESYS version:

cMT-CTRLO1 User Manual

CODESYS update

start

start

logout

enabled |change
192.1683. 21
255.255.252.0
192.168.1.254

20190822

leave.
'}1% Mew Project
Categories: Templates:
{1 Libraries - e
2 Projects | & ' 'E
Empty project  HMI project Standard Standard
project project w...

Standard
project w...

MName: cMT3090c

Location:

A project containing one device, one application, and an empty implementation for PLC_PRG

C:\Users\user\Documents

ok ||

Cancel l
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Select Weintek Built-in CODESYS. CODESYS software provides 6 languages that can be
selected in [PLC_PRG in:] drop-down list as shown below. Structure Text (ST) is used as an

example in this manual.

Standard Project X

You are about to create a new standard project. This wizard will create the following
= I objects within this project:
s
- One programmable device as specified below
- A program PLC_PRG in the language specified below
- A cyclic task which calls PLC_PRG
- A reference to the newest version of the Standard library currently installed.

Device: cMT-CTRL (Weintek Labs., Inc.) i

PLC_PRG in: |Ladder Logic Diagram (L) e

Continuous Function Chart (CFC)

Continuous Function Chart (CFC) - page-oriented
Function Block Diagram (FED)
Ladder Logic Diagram (LD}
Sequential Function Chart (SFC)

Double-click on Device (Weintek Built-in CODESYS) to open the settings window.

Devices - 0 X
=5 MT-CTRLOT -
= [ [pevice (MT-cTRL)
=81 pLC Logic

=} Application
m Library Manager
HF] PLC_PRG (PRG)
= @ Task Configuration

= @ MainTask
& pLC_PRG
m iBus (iBus)
|7 Device x N
Communication Settings 5can Network... | Gateway - | Device ~ |
Applications
.
Backup and Restare
Files . < .
Gateway
Log
ateway-1| - VB -
= IP-Address:
localhost
PLC Shell
Pork

1217
Users and Groups

Task Deployment
Status

Information

Open Scan Network tab, CODESYS software will start searching for the CODESYS devices
on the same network. Select the desired device and then click [OK] to leave. The last two
IP address parts (between dots) are converted into HEX digits and shown in this window.
For example, if the IP address of the CODESYS device is 192.168.2.118, please select HMI
Name[0276]. After clicking Wink button, CPU RUN LED flashes for three times.
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Select Device

Select the network path to the controller:

= .-jl.'i. Gateway-1{scanning...)
[l cMT-00 [0264]
cMT-8B28-ted [0209]
cMT-DDBA [0241]
cMT-DDE7 [0234]
cMT-E6CE [0243]
cMT-ERCS [025E]

=== ==

Device Name:
Gateway-1

Driver:
TCR/P

IP-Address:
localhost

Port:
1217

(sl

Sean network

Cancel

5. The project will connect the selected device.

Gateway

Gateway-1

IP-Address:
localhost

Port
1217

[0278] (active)

Device Name:
cMT-E33B

Device Address:
0276

Target ID:
16BF 0001

Target Type:
4096

TargetVendor:
Weintek Labs., Inc.

TargetVersion:
3.5.10.30

IP address of the device can be entered in the field shown below.

Gateway-1

IP-Address:

lacalhost

Por
1217

V1.0.1

Gateway

192,168.2.118

Prezs ENTER to set active path...
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Chapter9. Creating EasyBuilder Project
*Please use EasyBuilder Pro v6.04.01 or later versions.
9.1. Creating Tags

1.

@ Device PLC_PRG X

1 PROGRAM FLC_PRG

= p WAR
3 read:BOOL;
4 write:BOOL;
B test:INT;
& END VAR

1 testi=test+l;

9.2. Exporting Tags

cMT-CTRLO1 User Manual

Create several tags in PLC_PRG tab and make tag “test” accumulate automatically.

1. Right-click on Application in Devices tree and then select [Add Object] » [Symbol
Configuration], use defaults.
Add Symbol Configuration @I
®®  Createaremote access symbol configuration.
Name:
Symbaol Configuration
[] Include Comments in XML
[ Support OPC UA Features
Client side data layout
(7)) Compatibility Layout
@ Optimized Layout
[ Add ] [ Cancel ]

2. Find PLC_PRG, select the variables to be exported, and then click [Build].
Symbols Access Rights  Maximal =~ Attribute Type  Members
+-[[] [] constants
+ |:| IoConfig_Globals
= PLC_PRG

% read " "y BOOL

& test k] " INT

# write p "y BOOL
3.

V1.0.1

Select [Build] » [General code], the *.xml file can be found in the directory of the project.
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9.3. Configuring EasyBuilder
1. Create a project and select Weintek Built-in CODESYS in the device list.

|  ExtendedMemory |  CelblauwDatNetwork |  Time@ymedDST | eMail | Recipes
Device | Model | Generl | Systemfetting | Remote | ecuity
Deesvice list : What's my TP?
Mo. Mame Location Address type Inti
= [LocalHMI | Local HMI Local cMT3090 (768 x 1024) -
@ Local PLC4 | Weintek Built-in CODESYS Weintek Built-in CODE - |

Y

2. Open Tag Manager and click , and then click [Import Tag] to import the *.xml file

built in preceding steps.

Variahle List
MName @ I‘I’agTabIe Find [q ]
o X » ¢+ Mm@ AaD
Werifying Tags with device...
Symbols | Data Import Tags...

Tag

3.  The CODESYS tags can now be found in Tag Manager.

T A . Wl
My Application Variable List

- Application Name : ]TagTabIe Find : @
(- Tags
‘.- TagTable

o X » ¢ = @ 0 6 B

Symbols Data Type | Scan Rate (s) | Binary Access

EF Tag
Application.PLC_PRG.rcad

VBOOL |
INT Default  FALSE

Dcfault FALSE

= Application.PLC_PRG.writei BOOL |Default 3 FALSE

Import Status

Imported tag information successfully.
0 warning(s)

4. Create a Numeric object and use “Application.PLC_PRG.test” for address. After
downloading the project to HMI, “test” tag data can be found.

V1.0.1
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Chapter10. Connecting cMT-CTRLO1 CODESYS to iR Series Modules

1.

2.

V1.0.1

Right-click on [iBus (iBus)] and then select [Add Device].

Devices
=5 MT-CTRLOT
= [{ Deviee [MT-CTRL)
=81 pLC Logic
= u Application
m Library Manager
B¥] PLC_PRG (PRG)
= @ Task Configuration
=8 MainTask
8] PLC_FRG
ﬂi iBus (jBus)

Select an iR module and then click [Add Device].

[ Add Device 4

Name: |R_DI16_K

Action:

(® Append device (T Update device

|Enter a string for a fulltext search in all devices... | Vendor: | <all vendors: w
Mame Wendor Version  Description

= m Miscellaneous
ﬂj R-AID4-TR Weintek Labs., Inc. 1.0.0.0 4 x Temperature Input , RTD Thermocouple, Consumption(5V)-65mA f0. 3250
ﬂj R-AID4-VI Weintek Labs. , Inc. 1.0.0.0 4 x analog Input , 16 bit, =10V * £20mA + 1-5V * 4-20mA, Consumption{5V)-70n
ﬂj R-AMOENT Weintek Labs., Inc. 1.0.0.0 Analog,4 = Input 16bit , 2 = Qutput 12bit , =10V ~ £20mA ~ 1-5V ~ 4-20mA, Cor|
ﬂj R-AQO4-VT Weintek Labs. , Inc. 1.0.0.0 4 x analog output , 12 bit, £10V » £20mA » 1-5V » 4-20mA, Consumption(5V)-65

ﬂj R-DI16K Weintek Labs., Inc. 1.0.0.0 16 Points Digital Input, Consumption(5V)-83mA/0.413W

ﬂj R-DM16-0 Weintek Labs. , Inc. 1.0.0.0 & Points Digital Input,d Points Sink Type Digital Output, Consumption{5V)-130mAj

ﬂj R-DM16-P Weintek Labs. , Inc. 1.0.0.0 8 Points Digital Input,8 Points Source Type Digital Output, Consumption{5V)-130m
ﬂj R-DQOER Weintek Labs. , Inc. 1.0.0.0 8 Points Relay Output, Consumption{5V)-220mA/1.1 W

ﬂj R-DQ 16 Weintek Labs. , Inc. 1.0.0.0 16 Points Sink Type Digital Output, Consumption{5V)-205mA/1.02 W

ﬁj R-DQ16P Weintek Labs. , Inc. 1.0.0.0 16 Points Source Type Digital Output, Consumption{5V)-196mA,0.984 W

ﬂj R-PUOLP Weintek Labs. , Inc. 1.0.0.0 1-Axis Motion Controller (PA/PE), 1-Encoder (A/B/Z),4-point digital output,4-paint

£ >

Group by category [ Display all versions (for experts only) [ ] Display outdated versions

[ name:iR-DI6+ s
Vendor: Weintek Labs., Inc.
Categories: -
Version: 1.0.0.0 y]
Order Number: R-DI16+ v =

Append selected device as last child of
iBus

&  (You can select another target node inthe navigator while this window is open.)

Add Device Close

The added device can be found under iBus. You may add more modules with this window

is left opened.

= ﬂj iBus (iBus)
[ r_pris_K (R-DI164)

Double click on a module name to open iROption I/O Mapping.
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Devices > L X [{ ®r_pMi6_P %
=) MT-CTRIOL b
=/ (i Device (cMT-CTRL) iROption /0 Mapping Find Filter Show all -
= B ciLogc cotue Variable Mapping Channel  Address Unit  Description
=} Application = o o4IB2
M e e S » %o20
= {58 Task Configuration % :i:i;
= g MairTask 4 rx2.3
] pic_rrG % wn2a
=i iBus (Bus) 45 %INz.5
A ormonen | h
[ R_p115 K (R-DI16) 45 P
@ r_oqis P RDQiE) =Ty %080 24Vdc Source Output
[ iR_DQO8 R (R-DQOER) sy %ax0.0 oOL
[ R_A104 TR (R-AI04-TR) "% %OX0.1  BOOL
[ R_AMOS_VI (R-AMOE-VT) "y %x02  BOOL
[ iR_AI04_VI (R-AID4-VT) "% wpos oo
[ R_AQ04_vI (R-2Q04-VT) "% wpos 0oL
" %QX0.5  BOOL
g %06 BOOL
"% %QK0.7  EOOL
Analog modules, other modules, and their settings.
(1 iR_AT04_VI x
| iROption Parameters Parameter Type Walue DefaultValue Unit Description
=" Channel Detection UINT 255
Bophon Do # Channel 0 Input Detection BOCL EMABLE EMABLE
Status & Channel 1 Input Detection BOOL EMABLE ENABLE
& Channel 2 Input Detection BOCL EMABLE EMABLE
Information @ Channel 3 Input Detection BOOL EMABLE ENABLE
@ BIT4 BOOL 1 1
# BITS BOOL 1
# BITe BOOL 1
@ BIT7 BOOL 1
% Input Conversion Time Enumeration of UINT 2ms Fast Converison mode for only one channel
@ Channel 0 Input Mode Enumeration of UINT -10Ve+10V Voltage or Current Mode
@ Channel 1 Input Mode Enumeration of UINT -10Vee 410V Voltage or Current Mode
% Channel 2 Input Mode Enumeration of UINT -10Ve~+10V Voltage or Current Mode
@ Channel 3 Input Mode Enumeration of UINT ~10Ve~+10V Voltage or Current Mode
@ Channel 0 Input Scale Range Upper Limit INT 32000
% Channel 1 Input Scale Range Upper Limit INT 32000
@ Channel 2 Input Scale Range Upper Limit INT 32000
@ Channel 3 Input Scale Range Upper Limit INT 32000
% Channel 0 Input Scale Range Lower Limit INT -32000
@ Channel 1 Input Scale Range Lower Limit INT -32000
@ Channel 2 Input Scale Range Lower Limit INT -32000
4 Channel 3 Input Scale Range Lower Limit INT -32000
@ Channel 0 Input Filter Frame Size Enumeration of UINT 5 5 Allowable range : 0~20
@ Channel 1 Input Filter Frame Size Enumeration of UINT 5 Allowable range : 0~20
§ Channel 2 Input Filter Frame Size Enumeration of UINT 5 5 Allowable range : 0~20
@ Channel 3 Input Filter Frame Size Enumeration of UINT 5 5 Allowable range : 0~20

iBus has two addresses in BYTE type that show low voltage and 1/O error.

m iBus X
Internal Parameters Find Filter Show all -
Internal 10 Mapping Wariable Mapping Channel Address Type  Unit  Description
= ™o %IB0 BY

Status R LV wD.O B

% %IN0.1 B
Information R) BTN, 2 B

R/ %IN0.3 B

% %IN0.4 B

R/ %IN0.5 B

R/ %IN0.6 B

B %IN0.7 B

L %IB1

5.  Open PLC_PRG in Devices tree and configure variables as shown below.

1 FROGERAM FLC _FRG

p VAR
3 x0 : BOOL;
4 x1 : BOOL;

&  END VAR

6. In Devices tree double click on an iR module name to open object settings window. In

iROption I/O Mapping tab, select a variable for the object.
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@ r_DM16_P x

iROption If0 Mapping Find Filter Show all -
- Variable Mapping Channel  Address Type  Unit  Description
ER | IND %elB2 BYTE 24vdc Source /Sink Input
Information “p application,PLC_PRG.x0 "%  BITO wi2e  BOOL
4y Application. PLC PRG.x1 [, | " BIT1 FIENEY BOOL
BIT2 %elx2. 2 BOOL
BIT3 YeIx2.3 BOOL
EIT4 %elx2. 4 BOOL
EITS %IN2.5 BOOL
BITS eIX2.6 BOOL
EIT7 eIx2.7 BOOL
ouTo %e0B0 BYTE 24Ydc Source Output
EITO %QX0.0 BOOL

7. When finished, click [Online] » [Login] to download the project to CODESYS.
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Chapterll. Connecting cMT-CTRLO1 to iR-ETN

11.1. Connecting cMT-CTRLO1 to iR-ETN
1.

Right-click on Device (cMT-CTRLO1) and then select [Add Device].
2.

Select [Ethernet Adapter] » [Ethernet] and then click [Add Device]

[ Add Device

Mame: |Eﬂ1&rnet

Action:

(@ Append device (0) Update device

|Enter a string for a fulltext search in all devices... | Vendor: | <all vendors=

Mame

B
Vendor Version Description
+ ﬁ Miscellaneous

= m Figldbuszes
+ - AN CANbus
+. o EtherCAT
= EE Ethernet Adapter
ﬁ 35 - Smart Software Solutions GmbH

3.5.11.0 Ethernet Link.
+ - = EtherNet/IP

3. Ethernet (Ethernet) can be found in Devices tree.

Devices - o %

=5 MT-CTRLOT
=[] Device (cMT-CTRL)
=20 PLC Logic
=L} Application
m Library Manager
B PLC_PRG (PRG)
= @ Task Configuration
=-g¥ MainTask
] PLC_PRG
+ m iBus {Bus)
m |Eﬁ1ernet (Ethernet) |

4. Double-click on Ethernet with the current window opened in Devices tree or right-click on
Ethernet and then select [Add Device].
5. Click [Fieldbusses] » [Modbus] » [Modbus TCP Master] » [Modbus TCP Master], and then

select [Add Device].

m Add Device >

Name: |M0dbus_TCP_Master

Action:

(® Append device () Insert device (C) Update device

|Enterastring for a fulltext search in all devices. .. | Wendor: | <all vendors: 8

Mame Vendar Version Description

= m Fieldbusses

t - = EtherNet/IP
= Kl Modbus
= Wil Modbus TCP Master
ﬂj 35 - Smart Software Solutions GmbH 3.5.11.0 A device that works as a Modbus Master on E
+ - Wil ModbusTCP Slave Device
6. Double-click on Modbus TCP Master with the current window opened in Devices tree or
right-click on Modbus TCP Master and then click [Add Device].
7.  Click [Fieldbusses] » [Modbus] » [Modbus TCP Slave] » [Modbus TCP Slave], and then
V1.0.1
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select [Add Device].

[ add Device
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Name: |M0dbus_TCP_SIave

Action:
(® Append device () Insert device () Update device
|Enter a string for a fulltext search in all devices. .. | Vendor: | <Al vendors: w
Mame Wendor Version Description
= m Fieldbusses
=/ BEl Modbus
= Wil Modbus TCP Slave
ﬂj Modbus TCP Slave 35 - Smart Software Solutions GmbH 3.5.11.0 A generic Modbus device that is configured as S

8. Double click on Ethernet in the Devices tree, enter CODESYS’s IP address in General tab,
and then select [Change Operating System Settings]. When [Use operating System
Settings] is selected, settings on cMT-CTRLO1 will be used without being changed.

Devices * 0 X () Ethernet x
=43 MT-CTRLOI -
b ﬂj Device (cMT-CTRL) General Interface: |eﬂ10
=B PLE Logic
= . S Status
7 Application (O) Use Operating System Settings
m Library Manager Ethernet Device IO Mappin (@ iChange Operating System Settingsi
H¥) PLC_PRG (PRG) pping iChange Operating gs!
={#8 Task Configuration Information IPAddress 192 . 168 . 3 . 21
=58 MainTask
& PLC_PRG Subnet Mask 255 . 255 . 252 . O
+- (] iBus (Bus) Default Gateway 192 . 168 . 1 . 254
= m Ethernet (Ethernet)
= ﬁ Modbus_TCP_Master (Modbus TCP Master)
ﬁ Modbus_TCP_Slave (Modbus TCP Slave)

9.  When CODESYS is already connected, go to General tab and click the [...] button near
Interface field and select ethO.

Metwork Adapters X
Interfaces:

Maime Diescription 1P Address

o 127001

wnetl 102552552
IP Lddress 192 1688 . 3 . 21
Submet Mask 255 255 .252 .0

Defanlt Gateway 192 168 . 1 254

MAC Address 00:0C:26:1B:43:69

Canoe

10. Select Modbus_TCP_Slave in the Devices tree and then go to General tab to set up

V1.0.1

IR-ETN’s IP address and Unit ID.
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Devices > 3 x

=5 MT-CTRLOT -
= [ Device (cMT-CTRL)
=B PLC Logic
=L} Application
m Library Manager
BF] PLC_PRG (PRE)
= @ Task Configuration
=-g8 MairTask
& pLC_PRG
+ m iBus (jBus)
= m Ethernet (Ethernet)
= m Modbus_TCP_Master (Modbus TCP Master)
m |Modbus_TCP_SIave (Modbus TCP Slave)

[ Modbus_TCP_Slave x
General

Modbus Slave Channel
Modbus Slave Init
ModbusTCPSlave Parameters
ModbusTCPSlave If0 Mapping
Status

Information

Modbus-TCP
Slave IP Address:
Unit-ID [1..247]
Response Timeout (ms)

Port

11. Open [Modbus Slave Channel] tab and create Modbus Variable.

ModbusChannel

Channel

Name

Read 0x-0

X5

Access Type

[Read Discrete Inputs (Function Code 2)

Trigger [cydiic *| cycleTime (ms) 100

Comment

READ Register

Offsat 0x0000 -

Length 1

Errar Handling Keep last Value -

WRITE Register

Offset 0x0000

Length 0

OK ] [ Cancel ]

ModbusChannel IEI

Channel

Name Write Ox-0

Access Type

[Wrihe Multiple Coils (Function Code 15)

Trigger

[Cydic

Comment

READ Register
Offsat

Length 1

Error Handling

WRITE Register
Offset 0

Length i

Keep last Value

v] Cycle Time (ms) 100

ok ||

Cancel ]
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192 . 168 .

-

==
=
=

12. Open PLC_PRG in Devices tree, create tag and set Bool as data type. Write a command as

V1.0.1

shown below.
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1 FROGRAM FLC FRG
z VAR

3 read:BOOL;
4 write:BOOL;
5 EHD VAR

_ —

1 write:=1;

P

cMT-CTRLO1 User Manual

13. Open Modbus_TCP_Slave in Devices tree and then go to [Modbus_TCPSlave 1/0 Mapping]

tab to set up iR-ETN’s IP address and Unit ID.

Variable Mapping  Channel Addresz

o Read 0x-0 2%IB0

R Read 0x-0[0] %180
" 4@ Application.PLC_PRG.read i Bit0 BIXG-G

= T Write 0x-0 %GB0

=" Write 0x-0[0] %QB0
"4 Application,PLC_PRG. write T Bitd LI Y

Type

ARRAY [0..0] OF BYTE
EYTE

BOOL

ARRAY [0..0] OF BYTE
BYTE

BOOL

Unit  Description

Read Discrete Inputs
Read Discrete Inputs
0x0000

Write Multiple Cails
Write Multiple Cails

0x0000

14. When finished, click [Online] » [Login] to download the project to CODESYS.
Connecting CODESYS and Modbus TCP/IP Gateway
cMT-CTRLO1 supports Modbus TCP/IP Gateway which allows CODESYS to access Modbus TCP/IP
Gateway using Modbus TCP Slave, in order to control the devices connected to Modbus TCP/IP

11.2.

Gateway.

cMT-CTRLO1

10.255.255.1

Gateway ‘Weintek Built-in CODESYS

—_—

—
Modbus TCP/IP

Modbus
Gateway

7

LAN 2

comM1~3

a

PLC, Internet,

PLC, T/C, Inv. SQL server

Modbus TCP/IP

10.255.255.2

CODESYS

iBus

iR1/O
module

iR-ETN
Remote I/O

\

On cMT-CTRLO1, Gateway and CODESYS respectively use different IP addresses; therefore, by
adding Modbus_TCP_Slave for CODESYS and set IP address to 10.255.255.1, CODESYS is able to

connect to Modbus Gateway.

[ ™odbus_TcP_slave x|

General Modbus-TCP

Modbus Slave Channel Slave IP Address:

Madbus Slave Init Unit-ID [1.247]

ModbusTCPS|ave Parameters
Port

ModbusTCPSlave If0 Mapping

Response Timeout (ms)

. 255

=

. 255 .

1]

iI

502

To immediately display CODESYS data on HMI, values can be written to HMI’s LW registers for

V1.0.1
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objects to read. When setting Modbus Slave Channel, Cycle Time can be configured to adjust the

frequency at which data is written to the registers.

[l Modbus_TCP_Slave x

General Mame Access Type Trigger READ

0 Channel 0 Write Multiple Registers (Function Code 16) Cydic, t#100ms
Modbus Slave Channel

ModbusChannel *

Modbus Slave Init

Channel
ModbusTCPSlave Parameters Name Channel 0
ModbusTCPSlave If0 Mapping Access Type Wirite Multiple Registers (Function Code 16) ~

Trigger Cydic | Cycle Time (ms) -
Status ¥ E-

Comment | |
Information

READ Register

Offset Ox0000

Length 0

Error Handling Keep last Value

WRITE Register
Dffset |DxDDDD v |

Length

oK Cancel

For more information on Modbus Gateway, please see EasyBuilder Pro User Manual Chapter 37
MODBUS TCP IP Gateway.
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Chapter1l2. Removing Weintek Built-in CODESYS
1. Click [Tools] » [Packages Manager].
2. Find Weintek Built-in CODESYS and then click [Uninstall].

cMT-CTRLO1 User Manual

ez Package Manager

Currently installed packages:

=5

’ Install... ]

Uninstall...

Updates

Search updates

Sort by: |Name v]
Mame Version Installation date Update info License info
9 CODESYS SoftMotion 4,1.1.0 2017/11/27 Free version 4.3.1.0 available! Mo license req
.c.'.l Weintek Built-in CODESYS 2018.1.24 2018/2/2 License info ne
3. Click [Next] when seeing the window below.
& Uninstallation (=23
Weintek Built-in CODESYS [2018.1.24]
Uninstallation m
WEINTEX
The package will be removed from your system. Click Next to continue.
=E
4. Removing the program.
9 Uninstallation | 3 |
Weintek Built-in CODESYS [2018.1.24]
Pleasewaitwhilethepackageisbeing uninstalled. m
WEINTEX
Initializing...
5. Click [Finish].
V1.0.1
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£ Uninstallation @

Weintek Built-in CODESYS [2018.1.24] EI

The package has been successfully removed from your system. Click Finish to exit the
wizard.

cMT-CTRLO1 User Manual
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Chapter13. Frequently Asked Questions
13.1. Questions Related to CODESYS

Q1. When the indicator of CODESYS Gateway lights up in red, how can | connect to the device?
A: When CODESYS Gateway is not properly started or installed, its indicator will light up in red.

Gateway

Please try the following 3 methods to solve this situation.
1. Click the icon of “CODESYS Gateway SysTray” in system settings and then click [Start
Gateway].
2. Add new gateway and enter HMI IP.
Scan Metwork... || Gateway ~| Device -

| Add new gateway...

Manage gateways. ..

Configure the local Gateway...

Gateway @
Name: Gateway-2
Driver: [Tcp,r[p v]
IP-Address 192.168.2.144
Port 1217

3. Re-install CODESYS Gateway.

CODESYS V3.5 5P12 Patch 1 - InstallShield Wizard
Select Features
Select the features setup will install,
Select the features you want to install, and deselect the features you do not want to install.
. [¥|CODESYS V3 B
[¥]CODESYS Converter CODESYS Gateway ... Next
CODESYS Gateway generation gateway
ication | fo
[#]CODESYS OPC Server 3 ({:CSE'E“S“\PS'CEM =)l
[V]CODESYS Gateway V2.3
[ /] CODESYS Control Win v3
0.00 MB of space required on the C drive
11217.01 MB available on the C drive
[ < Back ][ Mext = ] [ Cancel ]

Q2. Why a triangle icon shows near Modbus_TCP_Slave device when | log in HMI in CODESYS

software?
iy ﬂj Modbus_TCP_Slave (Modbus TCFP Slave)

A: This means that HMI cannot connect Modbus TCP/IP device via CODESYS. Please check the

V1.0.1
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IP settings and make sure the cable is properly connected.

13.2. Questions Related to Downloading cMT CODESYS File
Q1. How to update CODESYS firmware?
A:
There are 2 ways to update CODESYS firmware.

cMT-CTRLO1 User Manual

1. Launch Utility Manager and select cMT Series » Maintenance » CODESYS Firmware

Update. Browse for the firmware file and click [Update].

' CODESYS Firmware Update

4] P HMIName |

HMI: cMT-E33B

Search All

Firmware : C:\codesys_20180704.229.bin

* Updating firmware will also restart HMI.

Password: 111111 [CIMask

Update

2. Enter cMT HMI’s IP address in the website browser and find [CODESYS] » [CODESYS

update] tab. Select the file and click [Update].

identity:
L System Setting

CODESYS
Network o

Date/Time Status  Project update  CODESYS update
AL Please select file to upload (*.bin)
History

. EEHEE | codesys_ 20150704229 bin
Email

Project Management
System Password
Enhanced Security

EasyAccess 2.0

CODESYS
L] *Note: Updating firmware will also restart HMI.

Update

Q2. How to download CODESYS project using website?
A:

1. In CODESYS software select [Online] » [Create boot application]. An *.app file and a *.crc

file will be generated.
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®» Manual.project - CODESYS

File Edit View

Project Build | Online | Debug Tools Window Help

;‘I% = n | @ | q Login Alt+Fa
Logout Ctrl+Fa
Devices | Create boot application
= -@ Manual Download
=[] Device (Weintek Buitin CC Online Change
= 8 PLC Logic Source download to connected device
= u Application

m Ethernet (Ethernet)

m Library Manag:
PLC_PRG {PRG
ol Symbol Config

= @ Task Configurs
= §§s MairTask

& pLC_p

Multiple Download. ..
Reset warm

Reset cold

Reset origin
Simulation

Security

Operating Mode

cMT-CTRLO1 User Manual

Enter cMT HMI’s IP address in the website browser and find [CODESYS] » [Project update]
tab. Select the files generated in the previous step and click [Update].

iden
L Systemi Setting

Network

Date/Time

HMI Name

History

Email

Project Management
System Password
Enhanced Security
EasyAccess 2.0

lii CODESYS

CODESYS

Status  Project update

Please select file to upload

JEIFHEE | Application.app
HEFEE | Application.cre

Update

CODESYS update

(*app)

(*crc)
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